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ASCENDER - Position Management: Update
NYR Positions and Move Employees to CYR
Payroll

This guide provides the necessary steps to update next year positions and move 12-, 11-, and
10-month employees to the current year payroll.

This guide assumes you are familiar with the basic features of the ASCENDER Business system
and have reviewed the ASCENDER Business Overview guide.

12-month Employees

This process moves employees who receive their first paycheck in July from next year Position
Management to current year Position Management. It also updates some of the fields on the
following Maintenance tabs in the current year (see step 7 for detailed information):

e Employment Info
* Pay Info

e Job Info

e Distributions

A separate simulation needs to be set up for employees who receive their first paycheck in July.
This is necessary because the position in the next year Position Management reflects the current
year’s salary information. The simulation updates the fields in the next year positions for the new
school year and clears the Accept Changes field. The new salary information from the next year
position is updated in the current year, updating both the current year Position Management and
the Staff Job/Pay Data fields for those employees. As 12-month employees do not accrue, it is not
necessary to move them to the next year payroll. Contact your regional ESC consultant to discuss
moving 12-month employees to the next year payroll.

Note: Depending on the LEA, it may not be necessary to set up separate simulations. If the LEA
has determined next year salaries and completed all interfacing to Budget for the year, one
simulation can be used when moving employees. Contact your regional ESC consultant to discuss
this option.

It is important to consider how this process affects the budget. If you update 12-month positions
with the new salary amount for the next school year in the next year Position Management,
running the simulation a second time at a later date for all employees gives the 12-month
employees an additional increase. If you were unable to update the budget with accurate salaries
for all employees prior to rolling 12-month employees, it is necessary to update Budget with
multiple simulations. Reference the Interface to Budget Checklist.

The following checklist assumes the LEA has interfaced the payroll salaries to Budget using the
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Salary Simulation process in Position Management.

TIP: Be sure to complete service records and extract June TRS before continuing this
process. This process updates the begin and end contract dates for 12-month employees
in the current year payroll. Service records must reflect the begin and end dates from
the current school year, and these dates are used to calculate the days and hours
worked for TRS purposes. This process will overwrite the employee’s calendar with the
calendar for the new year. If June TRS has not been extracted, the system is unable to
calculate this information for June.

1. Verify account code fiscal years.

Position Management > Utilities > Update Fiscal Year by Fund

Verify that the account code fiscal years are accurate. This tab provides a list of the fund/fiscal
years that are set up in the positions. This process increments the position distribution fiscal
year by 1.

Note: Since the account codes are validated against the budget, there should not be any
fiscal years less than the next year. If there are, generate a user-created report to identify
the positions and manually update the information.

2. Generate a user-created report.

Position Management > Reports > User Created Reports > CYR/NYR Positions

Generate a PMIS user-created report to verify that the Increase Eligible field is selected for
applicable positions. It is possible that the field is not selected for new LEA employees from last
year.

O It is recommended to verify the Nbr Remain Payments field prior to calculating salaries.

O Select the following fields on the user-created report:
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O Click Create Report. The report is displayed. Use the sort/filter functionality to group the

applicable data.

Note: The number of remaining payments reflected on the report is displayed on the Job
Info tab as the number of annual payments and the number of remaining payments for the
employee for any P position type. If the LEA uses S acct types or business allowances for
extra duties, S position types on this report should reflect the correct number of remaining
payments. Prior to continuing, make the necessary position corrections.

3. Verify retiree information.

Position Management > Maintenance > PMIS Position Modify > Budget

Verify that the TRS Status field is set to 5 - Retired for retirees. If the TRS status is incorrect,
there is a possibility that the status will be incorrect (TRS-eligible) when the employee is moved

to the current year payroll.
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4. ldentify employees to be moved to current year payroll.

Log on to the current year.
Payroll > Reports > User Created Reports

Generate a user-created report to identify the employees who begin their new contract in July. It
is possible that the employees are inactive in the current year, be sure that the Active
Employees Only field is not selected.
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O Prepare a list of new hires as a supplement to this list. Sort by the Payoff Date to verify that
all employees who have a June payoff date have the same date. For example, it is possible that
an employee has a payoff date that is a day before or after the actual June payoff date.

O Generate a user-created report again to verify that all of the data is accurate. Filter the report
using your LEA's June payoff date (YYYYMMDD).
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Print or save the report.

5. Create a salary simulation.

Log on to the next year.

Prior to setting up and performing salary simulations, review the Position Management:
Salary Simulations Overview guide for a description of the Salary Simulation pages and
samples of the available simulation reports.

Position Management > Utilities > Salary Simulation > Simulation Options
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If updating tables,
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Only:
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O Complete the following:

o (Recommended) In the Include Vacant Supplement Positions field, select No.

o In the Update Forecast field, select No.

o In the Update Budget field, select N - Do Not Update Budget.

o Include all first pay date codes for 12-month employees who receive their first paycheck
in July. Include all local/annual, hourly/daily, midpoint (if applicable), and extra duty
tables.

o If increases are not provided to 12-month employees in July, do not include an increase in
the salary tables. If increases are provided to 12-month employees in July, update the
salary tables with the increase data.

o If the LEA decides to interface the simulation to Budget, add the deductions with the
annual amount for the Employer Contribution.

O Click Save.

O Click Execute. Review the Simulation Process Error Listing and correct any errors prior to
continuing the process.

o Generate the simulation reports and review all salaries.

o Review the user-created report to confirm that all 12-month employees or positions are
included in the simulation. The reflected salaries are the amounts that are used to pay
employees in the current year payroll.

If necessary, continue making corrections and running the simulation until all of the salary
amounts are correct.
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O Run the final simulation. This process updates the included state step, pay step, and salary
amount in the next year PMIS for all 12-month positions and clears the Accept Changes field.

o In the Update Forecast field, select Yes.

o Click Save.

o Generate and save the reports.

o Click Process to process the simulation. Create a backup.

6. Copy school calendars from next year to current year payroll.

Log on to the next year.

Payroll > Next Year > Copy Next Year Tables

COPY NEXT YEAR TABLES *

1 O [ ” Select All Tables
] O
| O
] O :
] O =

Accrual Calendar

Extra Duty Pay

Hourly / Daily Salary

lob Code

Local Annual Salary

Midpaint Salary

| O &
@cuc (copcrcse ]
J O 3

State Minimum Salary

‘Workers' Compensation Rates

|
Substitute Salary [ ] O s
[ ILHE

O In the School Calendar field, select only the 12-month employee calendars.

./ TIP: The calendar code is displayed in the first pay date code on the simulation
& (e.g., J40 includes calendar code 40).

O Click Execute.

Note: If changes were made to the next year payroll tables (extra duty pay, hourly/daily
salary, job code, local annual salary, etc.), copy the tables from the next year payroll to the
current year payroll.

7. Generate a user-created report.
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Log on to the current year.
Payroll > Reports > User Created Reports

Generate a user-created report with the Hrs Per Day field selected. This field is overwritten
when positions are moved from the next year to the current year.

8. Move forecast to current year position and payroll

Log on to the next year.
Position Management > Utilities > Move Forecast to CYR Position and Payroll

This process is used to move payroll and position forecast records to the current year PMIS with
the same information that is set up in the next year PMIS records.

It also updates fields on the following Maintenance tabs: Employment Info, Pay Info, Job Info,
Distribution

The Accept Changes field must be cleared when moving position records from forecast to
current; otherwise, position records cannot be moved. The Accept Changes field is cleared
after running a simulation with the Update Forecast field set to Yes. Similarly, you cannot run
a simulation for positions without the Accept Changes field selected.

s
- Semimonthly CYR W ’

Select Pay Freguency:

5

Inclide Vacant Supplements:

Walidste Accounts against General Ledger

Update TRS Year Flag:

Update Workers' Comp Annual and Remaining Payments:

!HHDE

Add Additional Workers' Comp Payments:

Select State Minimum Salary Table (CYRMMNYR]):

- MaxtYear W

Select First Pay Date Codes or blank for ALL:

Include Extra Duty:

Select Extra Duty Codes or blank for ALL:

Select Positions or blank for ALL:

{Includes ALL billets for selected positions [ ] :]
Blank for ALL not processed when Positions/Billets selected)
Select Positions/Billets or blank for ALL: [ ] S

Select Supplement Positions or blank for ALL:

{Includes ALL billets for selected supplement positions [ ] :]
Blank for ALL not processed when Supplements/Billets selectad)
Select Supplement Positions/Billets or blank for ALL: [ ] [:]

Clear Job Years: D

Clear Job Weekly Hours Scheduled: D
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Select Pay Frequency

Click ¥ to select the pay frequency where you want to move
to the current year. This is a required field.

Include Vacant Supplements

Select to include the vacant supplement positions.

Recommendation: Do not select this field unless it is your
final move.

Validate Accounts against
General Ledger

This field is selected by default. Clear this field to not validate
the accounts against the general ledger.

Recommendation: Select this field if you are doing your first
test move. By doing so, the appropriate errors are generated
to inform you of incorrect account codes in PMIS. If not
selected, those account codes are moved to Payroll if each
account component is valid.

Update TRS Year Flag

Select to update the TRS Year field on the Payroll > Staff/Job
Pay Data > Job Info tab.

Recommendation: Select this field if the employees being
moved will receive a contract payment prior to the first pay
date of the new school year (i.e., July and August starts).

Update Workers' Comp
Annual and Remaining
Payments

Select to update the WC Ann Pymts and WC Remain fields
on the Payroll > Staff/Job Pay Data > Job Info tab.

The WC Ann Pymts field indicates the number of annual
workers' compensation payments for the contract period and
the WC Remain field indicates the number of remaining
workers' compensation payments to be made during the
contract period.

Add Additional Workers'
Comp Payments

Type the number of additional workers' compensation
payments. The field accepts any value between 0-9.

This field is helpful as it can be difficult to identify which
months have a third payroll for the biweekly frequency. You
can use this field to add one or two to the contract months
times two.

Select State Minimum Salary
Table (CYR/NYR)

Click ¥ to select the current year or next year. This is a
required field.

This selection determines which salary table is referenced
when calculating the state foundation salary.

Select First Pay Date Codes
or blank for ALL

Select the first pay date codes that begin their new contract
payout. Type the pay date codes, separating multiple pay
date codes with a comma but no space (e.g., 1,17,88,A1). Or,

click ¥ to search for pay date codes. Otherwise, leave blank
to use all pay date codes.

Include Extra Duty

Select to include extra duty in the process. If not selected, no
extra duty will be processed even if extra duty codes are
selected.
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Select Extra Duty Codes or
blank for ALL

Select all of the supplements as only those supplements that
are tied to an employee being moved based on the first pay
date code will be selected. You can select a supplement even
if it is tied to an employee who you do not want to pay yet.
Type the extra duty codes, separating multiple extra duty
codes with a comma but no space (e.g., 08,20,A2,TF). Or, click

! to search for extra duty codes. Otherwise, leave blank to
use all extra duty codes.

Select Positions or blank for
ALL (Includes ALL billets for
selected positions Blank for
ALL not processed when
Positions/Billets selected)

Type the position codes, separating multiple position codes

with a comma but no space (e.g., PRIN,T187). Or, click ¥ to
search for position codes. Otherwise, leave blank to use all
position codes.

Select Positions/Billets or
blank for ALL

Type the position/billet codes, separating multiple
position/billet codes with a comma but no space (e.g.,

PRIN/00001,PRIN/00006). Or, click  to search for
position/billet codes. Otherwise, leave blank to use all
position/billet codes.

Select Supplement Positions
or blank for ALL (Includes
ALL billets for selected
supplement positions Blank
for ALL not processed when
Supplements/Billets
selected)

Type the supplement position codes, separating multiple
supplement position codes with a comma but no space (e.g.,

PRIN,T187). Or, click ¥ to search for supplement position
codes. Otherwise, leave blank to use all supplement position
codes.

Select Supplement
Positions/Billets or blank for
ALL

Type the supplement position/billet codes, separating multiple
supplement position/billet codes with a comma but no space

(e.g., PRIN/O0O001,PRIN/00006 ). Or, click ¥ to search for
supplement position/billet codes. Otherwise, leave blank to
use all supplement position/billet codes.

Clear Job Years

Select to reset the job years to the default value (blank) on
the employee's job record.

If not selected and the employee's forecast position job code
is the same as the current year job master record, then the
new job record is populated with the values from the current
year job master record.

Clear Job Weekly Hours
Scheduled

Select to reset the weekly hours scheduled to the default
value (blank) on the employee's job record.

If not selected and the employee's forecast position job code
is the same as the current year job master record, then the
new job record is populated with the values from the current
year job master record.

O Click Execute to execute the process. The following reports are available:
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Processing Reports

[ Process

Mowe Forecast Process Ermor Listing

Report Mame

Update CYR Positons From Forecast

Update CYR Payroll From Forecast by Employee Name

oooo g

Update CYR Payroll From Forecast by Campus ID

o Move Forecast Process Error Listing Important errors

[ Generste Reports ] [ Celect Al Unselect AL

Error Message

Description

Warning: The employee has
Contract Balance amounts not
equal to zero for current jobs.

The employee has not been paid off by payroll.

Failure: Position Accept
Changes Flag setto Y

The position will not be moved to the current/payroll.

Failure: Emp Nbr must have
one position declared as
primary.

The error does not necessarily reference the Primary
Job field on the position. If an employee has a regular
position and a supplement position, but there is an

error that causes the primary position to fail, this
message often indicates that there is only a
supplement position to be moved. It is recommended
to review and correct any errors that begin below this
message about primary positions. After making those
corrections, run the process again. This may resolve
the primary job errors.

This error also occurs when calendars have not been
copied to the current year.
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Error Message

Description

Warning: Emp Nbr has
multiple supplement positions
for the same job; however,
one or more of the following
do not match: Campus ID,
Dept, TRS Status Code, FTE
Units, Incr Elig, Max Paymts,
FICA Elig, Unemp Elig, EEOC,
Workers Comp, Supplement
Extra Days or Category Cd.
The values from lowest
Supplement Position
Number/Billet may be used if
new rows are inserted for the
Pay Info and Job Info tabs.

This error indicates that the fields on the Payroll >
Tables > Salaries > Extra Duty tab do not match
those selected on a supplemental position.

Use the Position Management > Inquiry > PMIS Staff
Inquiry to determine the Position Number and Billet
for any supplemental positions for the employee.
Then, use the Position Management > Maintenance >
PMIS Supplement Modify page to retrieve the position
and billet and compare the fields on the position to
the Payroll > Tables > Salary > Extra Duty tab for the
extra duty number on the supplement. For example,
in some cases the W/C code on the position may not
match the W/C code on the table. Or, the Exp 373
field on the position may be selected, but the Exp
373 on the table for that extra duty code may not be
selected. Either the table or the position needs to be
updated so that they both match. If changes are
made to the Extra Duty table, it is necessary to move
the table to the current year payroll before
proceeding.

Date Run: Move Forecast o CYR Position and Payroll Ermors
Cnity Dist: 15D Pagec 1 of 4
Paosition Mbe Billet Mbr  Pos Typ  Eror Message

Failure: Emp Mir 000007 must have one position declared as primany.
Failure: Emp Mir 000128 must have one position declared as primary.
Failure: Emp Mbr 000148 must have one position declered as primany.
Failure: Emp Mir 000200 has unprocessad Reg Hours, Ovem Hours, or Abs Ded transmittals.

Failure: Emp Mo 000200 must have one position dechred as pimary.

Eaibire Emn Mo (08 o=t bave one nosition declbred s nrimses

o Update CYR Positions From Forecast - The error report lists any funds that need to be set
up in the Finance tables.

Date Runc Update CYR Positions From Forecast
Cnity Dist: IS0 Page: 1 of 1
Position Mbr Billet Mbr  Pos Typ Description Employpes Mumber Employee Name
Mo Rows Mo Rows “acant
End of Report

o Update CYR Payroll From Forecast by Employee Name
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Date Run: Update MR Payroll From Forecast by Employee Mame
Cnity Dist: 15D Page: 1 of 1
Schoaol Year:
Emp Mbr Employes Hame
Field Oid = Field Oid MNew Field Oid Mew
No Riows Vacant Freq:
Employment D=t Campus Contract Amount
Pay S=ws Primary Job Contract Remain Amt
FICA Eligibl= Creertime Eligible Pay Rate
Unermg Eligible Incre=ss Eligible Hriy/Diy Rate
TRS Status Calendar Code Crzrtmz Rate
Job Code St Sep Dock Rate
Pay Concept TRS Year Saate Min Szlary
Fay Type TRS Position Code Mbr Mon Contr
Contract Begin Dste Accrzl Code Mbr Annl Pymis
Contract End Dzte Ex=mpt Status Mbr Rem Pymts
Fayoff Cate hbr Days Contract Job Pt Az=gnd
Fay Grads hbr Days Empld Pict D=y Empld
Fay S=o Mz Cay= Hrs Per Day
Sched Wik's Comp Annl Mbr Diays OF
EEOC Code ‘Wrk's Comp Remain

o Update CYR Payroll From Forecast by Campus ID

Wrk's Comp Remain

Date Run: Update NYR Payroll From Forecast by Campus ID
Cnty Dist: 15D Page: 1 of 1
School Year:
Emp Mbr Employes Name
Field Oid = Field Oid Mew Field Oid Mew
Mo Rows Vacant Freqr
Employment Dats Campus Confract Amount
Fay Sw=tus Primary Joo Consract Remain Amit
FICA Eligible Crezstirme Eligible Pay Rate
Unemg Eligible Incre igible Hriy/Déy Rate
TRS Status Calendsr Code Iwertmz Fate
Job Code SiEte Swep Dock Rats
Pay Concept TRS Year Sazte Min Sslary
Pay Type TRS Position Code Nbr Mon Contr
Coniract Begin Cate Accrual Code Nbr Annl Pymts
Contract End Date Exemipt Status Mbr Rem Pymts
Fayoff Cate Wbr Days Contract Job Pt A==gnd
Fay Grads Mbr Days Empld Pt Day Empld
Pay B=c Max Day= Hrs Per Day
Wrk's Comp Annl Mbr Days Off

U Click Generate Reports. The selected reports are displayed. Review the report.

O Click Continue to view the next report. Or, click Return to return to the report selection

page.

O After reviewing all of the reports and correcting all errors, return to the report selection
page and click Process to move the forecast records to the current year. You are prompted

to create a backup.

After the process is completed, the actual update is performed. If the update is
successful, a message is displayed indicating that the move forecast updates were

processed successfully.

Reminder: If fund/fiscal year(s) were added to Finance based on the error report listing,
they should be deleted at this point.
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O Click Cancel to return to the Move Forecast to CYR Position and Payroll page without
moving the forecast records to the current year.

If corrections are processed, repeat this step.

Generate and save each report. Compare the Update CYR Positions From Forecast report to
the user-created report that was previously generated to confirm that all 12-month
employees are included. The last two reports contain the same information; one is sorted by
employee name and the other by campus ID. These reports reflect the existing salary in the
current year payroll and the new salary, which overwrites the current year payroll amounts.
Review the reports for accuracy.

9. Confirm that CYR salaries are accurate.

Log on to the current year.

Verify the current year data to confirm that the salaries are correct. The following fields are

updated:
W Matenance » Empiayreect infa. » Personnel =
Frplowte |’_ |
= Ir-201 )
R i =] [____ [ ~ ]
Vet e Erplopest I__: = ~
(s J s s 2
e [ - =
T =1 3|
— (m] L_
~] = o
~) =0
‘m)
: [ ~] ] [ ] [
m ™ @ — | , .
=] ] -l Y 0
e )1 O O O O O
- L | A F o Oog [
@ g =)
+@ | @ @
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~ Payroll B3

PAY BP0 BOE RFD DESTRIEAUTIONS DEDUCTIONS LEAVE BALANCE
e Withholding Certificate

Tax s
Pay S [} Ao w | D L Fling Stame ~]
Pay Campur: (D01 001 Schet v Urserplavmast B [7] 3 - Joes
Py Doagit D FICA Engislay [ Sutsiect b madicars | e

W Mgty b
Deack Fate 300 044 St 3Ot Dapancents

b of Exerptionz. 4 1 Ctar Espmgfion:

du D Incoee

L]
318]E

b Ot Dasuctoms

F5P St Salary Duts
SN NS CODE

PSP Seplf e Ciotie E

Coemrpct S
Cortract Batancw 81

Tves Amgant  Fomain Amt B Pymis
Ko Rows
Add
B Aot bitw Bigni Aot Tome Brahighe Bty doprt A
e e e e 11| rereerern 1 == vl -  E—ry
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%  Maintanance > Staf Jcb/Pay Dats ~ Payroll 55

BNV ] |

[PY INFO Ka

] CHSTREBUTIONS. DEDUCTIONS LEAVE BALAMCE

Delete  Selected  [ob Code Primgry 3§ Asgigrid Py Type

8 D 1158 - TECHNDLOGY TECHNICIANS i @ ittt

40T CONATRCHEd M

Ealance

El SLIGE Fehn Uiyt ]:_:.:,—_;_ [Irr—— W] BEEATRED JETe— e
oty Tisead: 2 of Dy Erplal
Contract Total ® Anveal Bymis

By [ OVMMRm () R 000

State Stap CI ¥rs in Canser Lacid [E "". L A RS Mamber Pos il Sap At oo
Seate Min Salary I—l Ferursiation Daily Rate W A d & of daryt Er
Cabendurloc info
Calendarfocal Opgons:

Years bob Exp ﬂ Lecal Contract Days: B-

Wirkery” Comg nfg

(- Code i B80S PRONADELADME Q001N v | T Ann Py [_.] W B g m)

Aczrusl mdo

Cipie I:I! cerual Rate ,. - Tows B ol Dwgn B

M Maintenance > Staff Job/Pay Data ~ Payroll 53
[ s ]

Employes: [ |

PAY INFO OB INFO DISTRIBUTIONS DEDUCTIONS LEAVE BALANCE

Delete Details  Job Code Extra Duty Account Type

Account Code Amount Percent
] o 1158 - TECHNOUOGY TECHNICIANS G 155-53-0125.00-535-259000 2530600 100.000%
Total 2830600 100.000%
Rows: 1of 1  Refrgsh Totals v}
soo fooe [ 1158 - TECHNOLOGY TECHMNICL W |
Extra Duty Code: [ w | Activity Code [£0 Base Salary w | l " .
Account Type: G Standard gross pay v] TRS Grant Code
Acoount Codw: (199-53-6129.00-395-299000 J Warker's Comp Code:  BE5S-PROFAIDES/ADMS.
geription
Daezcription; Expense 373 1‘. Account not used in ASE distr WV il
Amount 28.306.00 | out of 28.306.00 Ernployer Contribution IE[
ot 100.000% Performancs Pry D
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10. Mass update fiscal year.

Log on to the current year.

Payroll > Utilities > Mass Update > Employee

Skip this step if your LEA has a 7/1 fiscal year.

Mass update the fiscal year to the current school year for all employees.

Select Fiscal Year and type the current year fiscal year. Before processing, stop to consider if
the LEA uses other fiscal years in the account codes for employees. If the entered year is not
the only used fiscal year, additional parameters may need to be selected.

Contact your regional ESC consultant if you need assistance.

Identify those employees with a June payoff date and mass update the Hrs Per Day field.

o For LEAs that use the hours per day functionality in the current year payroll, select the
Hrs Per Day field and type the number of hours per day for the majority of employees.
o Use the parameters to select specific groups of employees for the update.

11-month Employees

This process moves employees who receive their first paycheck in August from next year
Position Management to current year Position Management. It also updates some of the
fields on the following Payroll >Maintenance > Staff Job/Pay Data and Personnel >
Maintenance > Employment Info tabs in the current year payroll (see step 16 for detailed
information):

e Employment Info
e Pay Info

e Job Info

e Distributions

A separate simulation will be set up for 10-month employees at a later date. This is
necessary because the position in the next year PMIS reflects the current year salary
information. The simulation updates the fields in the next year positions for the new school
year and clears the Accept Changes field. The new salary information from the next year
position is updated in the current year, updating both the current year PMIS and the Staff
Job/Pay Data fields for the employees. If 11-month employees accrue, it is important to
move them to the next year payroll in order to perform the accrual process.

Note: Depending on the LEA, it may not be necessary to set up separate simulations. If the
LEA has determined next year salaries and completed all interfacing to Budget for the year,
one simulation can be used when moving employees. Contact your regional ESC consultant
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to discuss this option.

It is important to consider how this process affects the budget. If you update 11-month
positions with the new salary amount for the next school year in the next year PMIS,
running the simulation a second time at a later date for all employees gives the 11-month
employees an additional increase. If you were unable to update Budget with accurate
salaries for all employees prior to moving the 12-month employees, it is necessary to
update Budget with multiple simulations. Reference the Interface to Budget Checklist
located at the end of this document.

The following checklist assumes that the LEA has interfaced the payroll salaries to Budget
using the PMIS Salary Simulation process.

1. Verify account code fiscal years.

Position Management > Utilities > Update Fiscal Year by Fund

Verify that the account code fiscal years are accurate. This tab provides a list of the
fund/fiscal years that are set up in the positions. This process increments the position
distribution fiscal year by 1.

Note: Since the account codes are validated against the budget, there should not be
any fiscal years less than the next year. If there are, generate a user-created report
to identify the positions and manually update the information.

2. Generate a user-created report.

Position Management > Reports > User Created Reports > CYR/NYR Positions

Generate a PMIS User Created Report to verify that the Increase Eligible field is selected
for applicable positions. It is possible that the field is not selected for new LEA employees
from last year.

TIP: For 10- and 11-month employees, it is recommended to verify the
i Nbr Remain Payments field prior to calculating salaries.

O Select the following fields on the user-created report:

[¢]

First Name
Last Name
Position Nbr
Billet Nbr
Position Type

[¢]

[¢]

[¢]

o
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o Increase Elig
o Nbr Remain Payments

PMIS Position/Distribution Export File Auto Select Options

[:| PMIS Position Control D PMIS Position Distribution

DPMIS Position Control

[)CYRINYR Flag

on Description

Position Status

Contract Beg Date
D Contract End Date
D Payoff Date
[ nor Days o

DDa\-' Empld Pct
DP:‘. of Year
DPET Concept
[Jeeot code
Workers" Comp

[ORs Pesition Code

) Pasition School Year
D Frequency

D Oec Employee Mbe
[ ]Primary Job

[ Increass Elig
|_JOec Pay Grade
D Oee Pay Stap

E] Occ Pay Schedule

Job Category

D Supplement Attached

[Jieb Cade

[0 15t Pay Date Code
D Calendar Code

D Campus 1D

[oept

[OMax Days

DMaA Payments
[OJowem Elig Fig

E]Sta:e Mimimum Days
[O5pvsr Position Nbr
[Ospver Bitler Mor
DS.;p:-Leme'\t Extra Days
DSJF‘D'. to Pos Mbr

D Extra Duty Code

D Supplemenit Type

G Supplament Max Amt
DBase Suppl On Dly Rate
[Jsupatement Pay 1 Time
DDE[E Supplement 1 Time

Ooat=Fin
[(JFill Positian Reasan

[ Date Criteria

D Date Awthorization

G Date Authorization End

[j Date Entry

DI”E; Step

DPEV Schedule
[JFTE - Equiv Units
[OMidpeint Base
DPE’C-;"II of Midpoint

Duqe-ﬂalc-.-me'.t Elig Flag
[JFica Elig

[OTRS Status Code
DBng et Amount
DBnget Salary Owverride
Da’\.“.. al/Budget Ind

D Oce Pay Type

D Suppl Recalculate

D Ign Pct Day For Sal Calcs
[Jign Pet ¥r Far Sal Cales
O Mew Employe

[:| Hrs Par Day [:|54|:-:J=. to Fos Billet D Date Inactive DPEV Type
DF’MIS Position Distribution
OcyRMNYR Flag Dok Code O Funeticn [JEd span [JExpense 373
ense 3
E]chi: on Mbr D.-‘-.cuu'.t Type E] Object E] Project Detail

DCm:'iI:- Acct Flag
DE...&: Mibr

[(JPasition Type
[Onistribution Sequence

E]Freu_encv

Dl"av Activity
[(Jwarkers* Comp
OFie D

DFu nd

[ sub Object

[ organization
[OFiscal Year

D Program Intent

D}‘u:cc unt Ameount
[ Accaunt Percant
[OJTRS Grant Cade
D Extra Duty Code

DEmpLoyae Demo

D Middle Mame D Generation

O Click Create Report. The requested report is displayed. Use the sort/filter functionality
to group the applicable data.

Note: Only positions with the Increase Elig field set to Y will receive a salary
increase. The number of remaining payments reflected on this report is the number
of annual payments and the number of remaining payments for the employee on the
Payroll > Maintenance > Staff Job/Pay Data > Job Info tab. Perform any position
corrections prior to continuing the process.

3. Identify the employees to be moved to the current year payroll.
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Log on to the current year.
Payroll > Reports > User Created Reports

Generate a user-created report to identify the employees who begin their new contract in
August. It is possible that the employees are inactive in the current year, be sure that the
Active Employees Only field is not selected.

[ e ) [ comrmn [ oame | mem ] o m—
Report Template
[ ]DPJL.: [ Retrieve ] [ Directary
Report Title
( )

Employee ﬂbr:]g [ Active Employees Only

[QEmPloyes Demographic

[OHispanic/Latina

[JAmerican ingian

oooEOElog

chb Information

[Dovertime Etigible O workers' Coma cd

ek code
Deser 0

[poe

time Rate [Owvorkers' Comp Annual

[Orrimary Job [OMbr Days i [OHoursDay [ODworkers' Comp Remain
DPui” Campus Dcalcraar Code D Local Contract Days DTﬁi Position Cd D Exempt Status
DCamous Name DCcu‘tra:'. Begin Dt D\:r of Annual Pymits D State Minimum Salary D Incr P
[OnerMen Cantr [Ocontract End Dt [Oremaining Pymts [ORS vear [Jvacant Position
[Oprs of lob Exper [Ois in Career Ladder [Jwkly Hrs Sched [Owholly Sep Amt [ Reg Hrs Waorked [ Retiree Exception

[istribution
ik cd [ Acet Type [JEstra Duty Cd [OwWaorkers' Comp [OPay Acty [Acct Amt [Acet Pet [JTRS Grant Cd [JExpense 373
OFund [ ! Oobject Osub object Oorganization  [JFizcalYear  [JProgram Intent [ed span [OFreject Detait
Ocontrib AcctFlg [ Perf Pay

[)Deductions.

[Opeduction d [Oemployes Amt [OEmployer Amt [Ofemain Pymts [0 Refund [Ocafe 125 [ Empilr Contrib Factor [ TEA Contrib Factar

O Prepare a list of new hires as a supplement to this list. Sort by the Payoff Date to
verify that all employees with a July payoff date have the same date. For example, it is
possible that an employee has a payoff date that is a day before or after the actual July
payoff date.

O Use the current year payroll Payroll > Maintenance > Staff Job/Pay Data > Job Info tab
to make corrections as needed.

O Generate a user-created report again to verify that all of the data is accurate. Filter the
report using the LEA's July payoff date (YYYYMMDD).
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SortFilter

[ v [] Sort Criteria l
| - Filter Criteria |

[ Add Criterion ] | Delete Selected

D Column Operator Value Logical

Fayof Dai= v = 20220725
a2 [ J

[ oK /| Cance

Print or save the report for verification purposes.

4. Create a salary simulation.

Log on to the next year.

Prior to setting up and performing salary simulations, review the Position
Management: Salary Simulations Overview document for a description of the Salary
Simulation pages and samples of the available simulation reports.

Position Management > Utilities > Salary Simulation > Simulation Options

2026/01/27 16:04 21 ASCENDER - Position Management: Update NYR Positions and Move Employees to CYR Payroll


https://help.ascendertx.com/business/lib/exe/detail.php/general/updatenyrpositionsmoveemployeestocyr_usercreatedreportfilterfeature.jpg?id=academy%3Abusiness_positionmanagement_updatenyrpositionsandmoveemployeestocyrpayroll
https://help.ascendertx.com/business/doku.php/academy/business_positionmanagement_salarysimulations
https://help.ascendertx.com/business/doku.php/academy/business_positionmanagement_salarysimulations
https://help.ascendertx.com/business/doku.php/positionmanagement/utilities/salarysimulation/simulationoptions

Business

Simulation Namg:] H Simulation Dmipﬁm:i ] i

SIMULATION OPTIONS FIRST PAY DATE CODES FUNDVFISCAL YEAR EXCLUSIONS LOCAL ANMUAL HOURLY/DAILY EXTRA DUTY MIDPOINT DEDUCTIONS UPDATE

If updating table

] ’ Add Simulation ] [ Execute ] [ Delete ] prior to using thi
Simulation Mame: :] Simulation Description: [ ] User ID:

Calculation Options Update Options

lz3se create export for Budget Tables

v]

Include Proposed Positions

1600 B

For Midpoint Salaries - Increase Pay Rate to

Pelimirn wnn:

Include TEA Health Insurance:

O Complete the following:

o (Recommended) In the Include Vacant Supplement Positions field, select No.

o In the Update Forecast field, select No.

o In the Update Budget field, select N - Do Not Update Budget.

o Include all first pay date codes for 11-month employees who receive their first
paycheck in August. Include all local/annual, hourly/daily, midpoint (if applicable),
and extra duty tables.

o If increases are not provided to 11-month employees in August, do not include an
increase in the salary tables. If increases are provided 11-month employees in
August, update the salary tables with the increase data.

o If the LEA wants to interface the simulation to Budget, add the deductions with the
annual amount for the Employer Contribution.

O Click Save.

O Click Execute. Review the Simulation Process Error Listing and correct any errors prior
to continuing the process.

o Generate the simulation reports and review all salaries.

o Review the user-created report to confirm that all 11-month employees or positions
are included in the simulation. The reflected salaries are the amounts that are used
to pay employees in the current year payroll.

If necessary, continue making corrections and running the simulation until all of the salary
amounts are correct.

O Run the final simulation. This process updates the state step, pay step, and salary
amount in the next year PMIS for all 11-month positions and clears the Accept Changes
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field.

o In the Update Forecast field, select Yes.

o Click Save.

o Generate and save the reports.

o Click Process to process the simulation. Create a backup.

5. (If applicable) Move employees to next year payroll.

Log on to the next year.
Position Management > Utilities > Move Forecast to NY Payroll

If your LEA uses ASCENDER Grade Reporting and/or accrues, 11-month employees may
need to be moved to next year payroll.

Execute

Select Pay Frequency: E - Semimonthly NYR W

Update TRS Year Flag:

Select First Pay Date Codes or blank for ALL- [.-'-.i"-';.C\.'\JE SPC ] [:]

Include Extra Duty:

Select Extra Duty Codes or blank for ALL: [ ] :]
Select Positions or blank for ALL:

{Includes ALL billets for selected positions [ ] :]
Blank for ALL not processed when Pesitions/Billets selected)

Select Positions/Billets or blank for ALL: [ ] [:]
Select Supplement Positions or blank for ALL:

{Includes ALL billets for selected supplement positions [ ] :]
Blank for ALL not processed when Supplements/Billets selected)

Select Supplement Positions/Billets or blank for ALL: [ ] ’:]

O Complete the following:

o In the Select Pay Frequency field, select the frequency that represents the LEA's
next year payroll.

o Select Update TRS Year Flag.

o In the Select First Pay Date Codes or blank for ALL, select the first pay date
codes that represent the 11-month employees.

o Select Include Extra Duty pay.

The additional fields can be used to move select employees and positions. V CV Click
Execute. Generate the Move Forecast Process Error Listing and correct any errors prior to
continuing the process.
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Processing Reports

Select Report Mame
Move Forecast Process Error Listing >
Update NYR Payroll From Forecast by Employes Name

D Update NYR Payroll From Forecast by Campus 1D

After completing any corrections, generate and save all of the processing reports.
O Click Process to process the final simulation.

Contact your regional ESC consultant if you need assistance.

6. Copy school calendars from next year to current year payroll.

Log on to the next year.

Payroll > Next Year > Copy NYR Tables to CYR > Copy Next Year Tables

COPY NEXT YEAR TABLES

Execute Select All Tables
Accrual Calendar [ Execute ] [ Select All Tables

Extra Duty Pay

lob Code

Local Annual Salary

[
(
Haurly / Daily Salary [
[
(
[

Midpoint Salary

{chool Calendar [copcrcse

State Minimum Salary

DDD\H)DDDDDD

[
Substitute Salary [
[

‘Workers' Compensation Rates

O In the School Calendar field, select only the 11-month employee calendars.

lf:' :fl TIP: The calendar code is displayed in the first pay date code on the

\

@' simulation (e.g., J40 includes calendar code 40

O Click Execute.
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Note: If changes were made to any of the next year payroll tables (extra duty pay,
hourly/daily salary, job code, local annual salary, etc.), copy the tables from the next
year payroll to the current year payroll.

7. Generate a user-created report.

Log on to the current year.
Payroll > Reports > User Created Reports

Generate a user-created report with the Hrs Per Day field selected. This field is
overwritten when positions are moved from the next year to the current year.

8. Move forecast to current year position and payroll.

Log on to the next year.
Position Management > Utilities > Move Forecast to CYR Position and Payroll

This process is used to move payroll and position forecast records to the current year
PMIS with the same information that is set up in the next year PMIS records.

It also updates fields on the following Maintenance tabs: Employment Info, Pay Info, Job
Info, Distribution

The Accept Changes field must be cleared when moving position records from forecast
to current; otherwise, position records cannot be moved. The Accept Changes field is
cleared after running a simulation with the Update Forecast field set to Yes. Similarly,
you cannot run a simulation for positions without the Accept Changes field selected.
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[ |

Select Pay Freguency:

Include Vatant Supplements:

Validate Accounts against General Ledger. D

Update TRS Year Flag
Update Wirkers' Comp Annual and Remaining Fayments:
Add Additional Workers' Comp Payments:

Select State Minimum Salary Table (CYR/MNYR):

Select First Pay Date Codes or blank for ALL:

Include Extra Duty:

Select Extra Duty Codes or blank for ALL:

Select Positions or blank for ALL:

{Includes ALL billets for selected positions [ ] :]
Blank for ALL not processed when Positions/Billets selected)

Select Positions/Billets or blank for ALL: [ ] :]
Select Supplement Positions or blank for ALL:

{Includes ALL billets for selected supplement positions [ ] :]
Blank for ALL not processed when Supolements/Billsts selected)

Select Supplement Positions/Billets or blank for ALL: [ ] :]

Clear Job Years: O

Clear Job Weekly Hours Scheduled: D

o In the Select Pay Frequency field, select the payroll frequency to be updated.
LEAs with multiple frequencies must individually process each frequency.

o Do not select Include Vacant Supplements.

o Do not select Validate Accounts against General Ledger at this time.
Distribution accounts in next year PMIS reflect the fiscal year for the upcoming
school year. Finance still reflects the current year for the fiscal year in the general
ledger. When running this process, the error report reflects funds for employees
who are included in the process. It is necessary to create the funds with the new
fiscal year on the Finance > Tables > Account Codes > Fund tab. It is NOT
necessary to set up codes in the Chart of Accounts.

o Select Update TRS Year. If an employee has this field selected but they are now a
10-month employee, the TRS Year field is cleared when the 10-month move is
processed.

o Select Update Workers’ Comp Annual and Remaining Payments if the LEA
expenses worker's compensation in ASCENDER. The system references the # of
months in Contract and makes the WC Ann Pymts and WC Remaining Pymts
match this field.

o Leave the Additional Workers’ Comp Payments field blank. It is not necessary
to populate this field even if the LEA expenses workers' compensation in
ASCENDER.

o In the Select a Stat Minimum Salary Table (CYR/NYR) field, select the year
(current or next ) that contains the tables with the updated amounts. If it is a
legislative year and the state minimum amounts are updated.

o In the First Pay Date Codes or blank for ALL field, select only the first pay date
codes for employees who receive their first paycheck in July.

o Select Include Extra Duty to include the supplement pay with the regular pay.
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O Click Execute to execute the process. The following reports are available:

Processing Reports

Select Report Mame

D Move Forecast Process Ermor Listing

D Updzte CYR Positions From Forecast

D Update CYR Payroll From Forecast by Employee Name

D Update YR Payroll From Forecast by Campus ID

[ Generate Reports ] [ Select ALL ] [ Unselect AL ]

o Move Forecast Process Error Listing Important errors

Error Message Description

Warning: The employee has
Contract Balance amounts

not equal to zero for current The employee has not been paid off by payroll.

jobs.

Failure: Position Accept The position will not be moved to the

Changes Flag set to Y current/payroll.

Failure: Emp Nbr must have The error does not necessarily reference the

one position declared as Primary Job field on the position. If an employee
primary. has a regular position and a supplement position,

but there is an error that causes the primary
position to fail, this message often indicates that
there is only a supplement position to be moved.
It is recommended to review and correct any
errors that begin below this message about
primary positions. After making those corrections,
run the process again. This may resolve the
primary job errors.

This error also occurs when calendars have not
been copied to the current year.
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Error Message

Description

Warning: Emp Nbr has
multiple supplement
positions for the same job;
however, one or more of the
following do not match:
Campus ID, Dept, TRS Status
Code, FTE Units, Incr Elig,
Max Paymts, FICA Elig,
Unemp Elig, EEOC, Workers
Comp, Supplement Extra
Days or Category Cd. The
values from lowest
Supplement Position
Number/Billet may be used
if new rows are inserted for
the Pay Info and Job Info

This error indicates that the fields on the Payroll >
Tables > Salaries > Extra Duty tab do not match
those selected on a supplemental position.

Use the Position Management > Inquiry > PMIS
Staff Inquiry to determine the Position Number
and Billet for any supplemental positions for the
employee. Then, use the Position Management >
Maintenance > PMIS Supplement Modify page to
retrieve the position and billet and compare the
fields on the position to the Payroll > Tables >
Salary > Extra Duty tab for the extra duty number
on the supplement. For example, in some cases
the W/C code on the position may not match the
W/C code on the table. Or, the Exp 373 field on
the position may be selected, but the Exp 373 on

tabs. the table for that extra duty code may not be

selected. Either the table or the position needs to
be updated so that they both match. If changes
are made to the Extra Duty table, it is necessary
to move the table to the current year payroll
before proceeding.

Date Run: Move Forecast to CYR Position and Payroll Ermors

Cnity Dist: 1D Page 1 of 4

Position Mbr Billet NMbr PosTyp Emor Message

Failure: Emp MNor 000307 must have one position declared as pimany.
Failure: Emp Mor 000128 must have cne position declared as primany.
Failure: Emp Mor 000148 must have one position dectared as primany.
Failure: Emp Mor 000200 has urgrocessad Reg Hours, Owen Hours, or Abs Ded transminzls.
Failure: Emp Mor 000200 must have one position declared as primany.

Ezikire: Emen Mo 0496 must bave one nostion declared =5 nomsoy

o Update CYR Positions From Forecast - The error report lists any funds that need to
be set up in the Finance tables.

Date Run: Update CYR Positions From Forecast
Cnty Dist- D Page 1 of 1
Position Mbr Billet Mibw  Pos Typ Description Emplioyee Mumber Employes Name:
Mo Rows Mo Rows acarit
End of Report

o Update CYR Payroll From Forecast by Employee Name
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Update MR Paymoll From Forecast by Employes Mame
15D Page 1 of
Oid Mewr Field Oid
Conéract Amount
Contract Remain Amt
Fay Rawe
HriyDéy Rate
THS Status Creertmz Rate
Job Code Dock Rats
Pay Concept Sw=te Min Szlary
Fay Type Mbr Maon Contr
Contract Begin Cate Mbr Annl Pymts
Contract End O=te E Mbr Rem Pymts
Payaff Cate Mbr Days Contract Job Pt A=sgnd
Pay Grads Wbr Day= Empld Pct Day Empld
Fay S=o Nz Cay= Hrs Per Day
Wrk's Comp Annl Mbr Days Off
Wrk's Comp Remain
o Update CYR Payroll From Forecast by Campus ID
Date Runc Update NYR Payroll From Forecast by Campus ID
Cnity Diist- 15D Page 1 of
School Year:
Emp Mbr
Field Oid MNew Field Oid
No Rows Vacant
Employment Dst= Contract Amount
Pay B=tus Contract Remain Amt
FICA Eligibl= Fay Raw
Unemi Eligibls Hriy/Déy Rate
TRS Status Creertime Rate
Job Code Diock Rats
Pay Concept Sa=te Min Safany
Pay Type TRS Position Code Mbr Mon Contr
Coriract Begin Date Accruzal Code Mbr Annl Pymis
Contract End Dste Exzmpt Status Nbr Rem Pymts
Mbr Days Contract Job Pct A=sgnd
Mbr Days Empld Pct Day Empld
Max Cay= Hrs Per Day
Wrk's Comp Annl Nbr Days Off
Wrk's Comp Remain

O Click Generate Reports. The selected reports are displayed. Review the report.

O Click Continue to view the next report. Or, click Return to return to the report
selection page.

O After reviewing all of the reports and correcting all errors, return to the report
selection page and click Process to move the forecast records to the current year.
You are prompted to create a backup.

After the process is completed, the actual update is performed. If the update is
successful, a message is displayed indicating that the move forecast updates were
successfully processed.

O Click Cancel to return to the Move Forecast to CYR Position and Payroll page
without moving the forecast records to the current year.

If corrections are processed, repeat this step.
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Generate and save each report. Compare the Update CYR Positions From Forecast
report to the user-created report that was previously generated to confirm that all 12-
month employees are included. The last two reports contain the same information;
one is sorted by employee name and the other by campus ID. These reports reflect the
existing salary in the current year payroll and the new salary, which overwrites the
current year payroll amounts. Review the reports for accuracy.

9. Confirm that the CYR salaries are accurate.
Log on to the current year.

Verify the current year data to confirm that the salaries are correct. The highlighted fields
are updated:

M Maintenance > S obPay Dats w Payroll 5§
Emgierps |
Ll 2] DESTRIEUTIOMNS: DEDUCTIONS LEAWE BALANC

id |

Iy

—)
De I:l

R [

Q.00
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M Maintenance » 518 jotyPay Duts + Fayroll 55

[PAY INFO 108 NFO DISTRIBUTIONS DEDUCTIONS LEAVE BALAMCE

Delete  Selected Job Code

a B 11155 - TECHNOLDGY TECHNICIANS JE

e w Dy s Per O

EI)._ ek I,_._t midin

e Py Samep

Fa
Rangining Pymes
ok g Pt

ERG AL

Saate infy

Statw Step CI ¥rs in Carger Lackd [E G.- fear  [7]  TRSMemberPos
zate hiin Salary I—'-l n Dty Rrte ¥ B Azzigreed

Catendanlocs infg

CalendaniLocal Dptons Ban Date

Lecal Contract Duys: G

Yasrs jobs Exp

Warery' Comp Info

G\r Cli corusl Rine ) - Tots Bl Qs B

M Maintenance > Staff Job/Pay Data ~ Payroll Eg

Emploves: [ ] [ Reve == |

PAYINFO  JOB INFOQ DISTRIBUTIONS DEDUCTIONS LEAVE BALANCE

Delete Detalls  Job Code Extra Duty Account Type Account Code Amount Percent
2] fo] 1158 - TECHNOLOGY TECHMICIAMNS G 199-53-0122.00-995-299000 2830800 100.000%
Totak: 2830600 100.000%

Rows: 1of 1  Refresh Totals

Job Code | 1158 - TECHNOLOGY TECHMICL W |
Extra Duty Code V) Activity Code [20 Base Salary v I R
Account Type: [ G Standard gross pay v TRS Grant Code
Account Code:  [199-53-6129.00-995-299000 | § Worker's Comp Code:  8868-PROS/AIDES/ADMS
Degcription: Expense 373 [M Agcount not used in ASB distr v |
Amcunt [ 28.30600] ut of 2830600 Employes Contriton: ()
CE'CE"IL 100.000% Performante Pay D J

10. Mass update fiscal year.
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Log on to the current year.

Payroll > Utilities > Mass Update > Employee

Skip this step if your LEA has a 7/1 fiscal year.

Mass update the fiscal year to the next school year for all employees.

Select Fiscal Year and type the next year fiscal year. Before processing, stop to consider
if the LEA uses other fiscal years in the account codes for employees. If the entered year
is not the only used fiscal year, additional parameters may need to be selected.

Contact your regional ESC consultant if you need assistance.

Mass update the current year Wkly Hrs Sched and Hrs Per Day fields.

o Select Wkly Hrs Sched and type the number of hours displayed for the majority of
employees. Any exceptions can be manually updated in the current year payroll.
Reference the previously generated user-created report.

o For LEAs that use the hours per day functionality in the current year payroll, select
the Hrs Per Day field and type the number of hours per day for the majority of
employees.

o Use the parameters to select specific groups of employees for the update.

11. Generate the HRS6000 Account Code Comparison Report.

Payroll > Reports > Payroll Information Reports > HRS6000 - Account Code Comparison

This report compares the account code on the employee’s master distribution record and
compares it to the Chart of Accounts in Finance file ID C.

O Complete the following parameters:

HRSE000 - Account Code Comparisan

Parameter Description Walue

/Sz:t_hy Alpha (A). Pay Campus |C). Primary Campus (F)

Include Reports {Select From List)

From Date (MMDDYYYY)

To Date (MMDDYYYY)

\E:\:_S'.atus. Active |A), Inactive |[], or blank for ALL . A
Fay Type 1-4, or blank for ALL
Select Pay Campusies). or blank for ALL :] H
Select Primary Campus(es), or blank for ALL :] :
Select Employes(s). or blank for ALL [:] :

If the LEA has multiple pay frequencies, generate the report for each frequency. The
generated report should be blank. If any account codes are listed, determine if the
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account codes need to be added to the Chart of Accounts in Finance or if the employee
distribution record needs to be modified.

12. Generate the HRS6050 Contract Balance Variance Report.

Payroll > Reports > Payroll Information Reports > HRS6050 - Contract Balance Variance
Report

This report looks at the pay rate for each employee and multiplies it by the number of
remaining payments, and compares that amount to the Contract Balance on the Job Info
tab. If there is a variance of more than a few pennies, perform manual calculations to
determine if any corrections are needed.

Generate the report for pay type 1 and again for pay type 2.

O Complete the following parameters:

[ Preview ] [ FPDF ] [ (=Y ] [ Clear Options ]
Payroll Information Reparts HRS6050 - Contract Balance Variance Repart
HRS1250 - Employes Data Listing
HRS1650 - Employees Salary Information i
HRSE000 - Account Code Comparison ;:irﬂew ReFintion bl
HRSE050 - Contract Balance Wariance Report =
HRS6150 - Employee Payroll Listing et o (R B e 16T R iy o =1 )
HRS6400 - Salary Verification Report Maximum Acceptable Difference
HR56450 - Health Insurance Coverage
HRSE6650 - CYR/MYR Salary Comparison Pay Status Active (A}, Inactive {I], or blank for ALL ;
Pay Type 1-4, or blank for ALL [
Select Pay Campusies). or blank for ALL :] H
Select Primary Campus|es), or blank for ALL :] H
Select Employee(s). or blank for ALL :] H
[Date Run: Contract Balance Varfance Report Program: HRS6050
Cnty Dist: 15D Page: 1 of 2
Variance Threshold: 010 Fraquancy: E
Emp Nbr Employes Nama Job Cd Pay Rate Romain Pymis Computed Bal Actual Bal Varlance
000018  AGUILAR, AIDA 1602 11.32 24 27168 16.478.00  16.206.32
000148  AHOURLY JR, OMNLY M 1504 14.38 24 3512 2091000 29564 88
000831 AHOURLY, REGULAR 1504 10.24 24 4576 2128800 2105324
000060  AYALA, ANS M 154 1,150.38 24 27.609.12 27,609.00 =12
000080 BEASLEY, ANTONIO 1602 11.92 24 286.08 15,824.00 15,537.92
0000G5 BERRELEZ, BARBARA L 1353 B93.88 24 2145312 21,453.00 =12
000057 BERRELEZ. BELINDA ROSARIO 1602 88.35 24 212040 16.522.00 14,401 60
000102 BISHOP, BENITA IRENE 1455 820.38 24 19.689.12 19.689.00 - 12
000148 CAMTU, CARMEN 1702 15.66 24 ar5.84 2254500  22169.16
000167 CARRIZALES. CHERYL K 1508 13.82 24 331.68 28,746.00 2841432
000187 CASTRO-VELA, CONCEPCION C 1309 2,135.38 24 51.249.12 51.249.00 =12
000183 CERVANTES, CONSUELO 1502 15,93 24 38232 3313400 3275168
L 00025  CORRFA DAMIFL 1508 13 41 24 29 Ag TRAAO0 2T 579 8 |

13. Enter new hire data.

Log on to the current year.

Use the Staff Job/Pay Data pages to enter new hire data. The HRS1550 - New Hire Report
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is helpful to identify these employees.

When new hires are entered in the next year Position Management and moved to the
current year payroll, only the fields related to the position are populated.

Manually update the following:
Personnel > Maintenance > Employment Info

o Employee Status

Highest Degree

Percent Day Employed

Original Employment Date or Latest Re-Employment Date
Retirement Date (if applicable)

o Years of Experience

o Employment Type

[¢]

[¢]

[¢]

o

Payroll > Maintenance > Staff Job/Pay Data > Pay Info

o Pay Campus

FICA Eligibility
W-4 Marital Status
Nbr of Exemptions
Bank Information

[¢]

o

[¢]

[¢]

Complete the Payroll > Maintenance > Staff Job/Pay Data > Deductions tab.

Payroll > Maintenance > Staff Job/Pay Data > Leave Balance - This tab can be updated in
September using the First Pay Date of the School Year instructions.

14. Run payroll calculations.

Log on to the current year.
Payroll > Payroll Processing > Run Payroll

Run payroll calculations to verify any errors.

10-month Employees

This process moves employees who receive their first paycheck in September from
next year Position Management to current year Position Management. It also updates
some of the fields on the following Maintenance > Staff Job/Pay Data tabs in the
current year payroll:

e Employment Info
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e Pay Info
e Job Info
e Distributions

Set up a separate simulation for employees who receive their first paycheck in
September. If all of the employees receive their first check in September, you can use
the simulation that was used for budgeting purposes. The simulation updates the
fields in the next year positions for the new school year and clears the Accept
Changes field. The new salary information from the next year position is updated in
the current year, updating both the current year PMIS and the Staff Job/Pay Data
fields for those employees.

1. Verify account code fiscal years.

Position Management > Utilities > Update Fiscal Year by Fund

Verify that the account code fiscal years are accurate. This tab provides a list of the
fund/fiscal years that are set up in the positions. This process increments the
position distribution fiscal year by 1.

Note: Since the account codes are validated against the budget, there should
not be any fiscal years less than the next year. If there are, generate a user-
created report to identify the positions and manually update the information.

2. Generate a user-created report.

Position Management > Reports > User Created Reports > CYR/NYR Positions

Generate a PMIS user-created report to verify that the Increase Eligible field is
selected for applicable positions. It is possible that the field is not selected for new
LEA employees from last year.

O It is recommended to verify the Nbr Remain Payments field prior to
calculating salaries.

O Select the following fields on the user-created report:
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| | oo P

PMIS Position/Distribution Export File Auto Select Options

D PMIS Position Control D PMIS Position Distribution

DPMIS Position Control

[]CYRMYR Flag D Contract Beg Date DDav Empld Pt D Extra Duty Code
Position Nbr [Ocoentract End Date [OPct of Year O supalement Type Do Pay Type
(O rayoff Date [OFray Concept [Osupplement Max Amt Oray Grade [ suppl Recalculats

[OMbr Days off Oezo [JBase Suppl On Dly Rate [Oray sten (Jign Pet Day For Sal Cales
[ et Hrly Dly Rate W [Osupplement Pay 1 Time [Oray Schedule [Jign Pet ¥r For Sal Cales
[]Satary Amount [Opate Supplement 1 Time [OFTE-Eq i O new Employee

Hbr Remain Payments [OMax Days [ ccept Change [Owidpein
D Frequency Job Category DMaa Payments = E]I"e'ch nt oint
DO.;: Employes MNbr D Supplement Attached DU-.-'. lig Flg D..Ae"ﬂl yment Elig Flag

[Jteb Code [Jstate Mini [JFica Elig
[ 15t Pay Date Code [Ospvsr Position Nbr 5
D Calendar Code DSO vsr Billet Nbr
Campus ID DSJPO lement Extra Days alary Owerride
Ooept [Osueet to Pos Ner O#ctualiBudget Ind
D Hrs Per Day DSJPO.tC Pos Billet DPEr Type
[JPMIS Position Distribution
O CYRMYR Flag [Oicb Code [OFunction [Oed span
i br D.ﬁcc;u’.t Type D Object D Project Detail

D Billet Nbr E]F‘ay Activity D Sub Object D}‘u;:c unt Amount

[JPesition Type [Owerkers' Comp [Oorganization [OAccount Parcent

[Oistribution Sequence OFiteiD [OFiscal Year [OJTRS Grant Cade

D Frequency DFu nd D Program lntent D Extra Duty Code

DEmpl.ovee Demo

[OMiddle Mame [ Generation

O Click Create Report. The report is displayed. Use the sort/filter functionality to
group the applicable data.

Note: The number of remaining payments reflected on the report is displayed
on the Job Info tab as the number of annual payments and the number of
remaining payments for the employee for any P position type. If the LEA uses S
acct types or business allowances for extra duties, S position types on this
report should reflect the correct number of remaining payments. Prior to
continuing, make the necessary position corrections.

3. Verify retiree information.

Position Management > Maintenance > PMIS Position Modify > Budget

Verify that the TRS Status field is set to 5 - Retired for retirees. If the TRS status is
incorrect, there is a possibility that the status will be incorrect (TRS-eligible) when
the employee is moved to the current year payroll.
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4. ldentify employees to move to the current year payroll.

Log on to the current year.
Payroll > Reports > User Created Reports

Generate a user-created report to identify the employees who begin their new
contract in August. It is possible that the employees are inactive in the current year,
be sure that the Active Employees Only field is not selected.

o [ o [ e ] - E—

Report Template

Report Title

Employeabr 3| [[JActive Employess Only

[JEmployes Demographic

[ wsiten ame
= umber 7 i
O~

Ocameus Mame
[OMbr Mon Cantr
[y of Job Exper

[Opistribution

[Oesara bury cd [Oworkers' Comp et Ame et Fer
Oobiect Osub Object [Fiscal Year [OPregram Inter
[)Deductions
[Opeduction ca Employee Amt [Oemployer Amt [OJremain Pymrs [Orefund [Ocate 125 [DEmpir Contrib Factor [JTeA contrib Factor

O Prepare a list of new hires as a supplement to this list. Sort by the Payoff Date
to verify that all employees with a July payoff date have the same date. For
example, it is possible that an employee has a payoff date that is a day before or
after the actual July payoff date.

O Use the current year payroll Payroll > Maintenance > Staff Job/Pay Data > Job
Info tab to make corrections as needed.

O Generate a user-created report again to verify that all of the data is accurate.
Filter the report using the LEA's July payoff date (YYYYMMDD).

2026/01/27 16:04 37 ASCENDER - Position Management: Update NYR Positions and Move Employees to CYR Payroll


https://help.ascendertx.com/business/doku.php/payroll/reports/usercreatedreports
https://help.ascendertx.com/business/lib/exe/detail.php/general/updatenyrpositionsmoveemployeestocyr_usercreatedwithpayoffdate.jpg?id=academy%3Abusiness_positionmanagement_updatenyrpositionsandmoveemployeestocyrpayroll
https://help.ascendertx.com/business/doku.php/payroll/maintenance/staffjobpaydata/jobinfo
https://help.ascendertx.com/business/doku.php/payroll/maintenance/staffjobpaydata/jobinfo

Business

Sort/Filter

[ " Sort Criteria

| - Filter Criteria

[ Add Critenion ] | Delete Selected |
D Column Operator
O | Fayof Daie w | [=w]

Value Logical

(20220825 |

Cancs

Print or save the report for verification purposes.

5. Create a salary simulation.

Log on to the next year.

Prior to setting up and performing salary simulations, review the Position
Management: Salary Simulations Overview document for a description of the
Salary Simulation pages and samples of the available simulation reports.

Position Management > Utilities > Salary Simulation > Simulation Options

Include Proposed Positions:

<I'|:.u de Vacant Supplement Positions:

Increment Pay Steps.

Maximum Annual Pay Step:

Maximum Hourly/Daily Pay Step:

Increment State Staps oo W
Include TRS On-Behalf Calculations:

Expenditure Account for TRS On-Behalf (XXX 61 44 XXX XHXAHK

J

Calculations:

For Midpoir - Basis of Salary Change [C-i_s='L-Jst:nhr..u'clvra:e

¥

- Increase Pay Rate to

Minirnum:

Include TEA Health Insurance:

Namﬁ ]: o D=.uip|.im1 ] .
SIMULATION OPTIONS FIRST PAY DATE CODES FUND/FISCAL YEAR EXCLUSIONS LOCAL ANNUAL HOURLY/DAILY EXTRA DUTY MIDPOINT DEDUCTIONS UPDAT]
If updating tables, please create export for Budget Tables
Retriave ] [ Add Simulation ] [ Execute ] [ Delete ] prior to using this utility.
Simulation Name: :] Simulation Description: [ ] User ID:
Calculation Options Update Options
hd

Update for Active Positions

[5 - Move Actual Amount to Budget Amount

Only:

Update Forecast

[‘l - Do not update Budget

>

R - Recommended Amount %

Update Budget Amount:

Reund Budget Amount to
nearest dollar
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[ Complete the following:

o (Recommended) In the Include Vacant Supplement Positions field,
select Yes to budget for vacant supplement positions.

o In the Update Forecast field, select No.

o In the Update Budget field, select N - Do Not Update Budget.

o Include all first pay date codes for 10-month employees who receive their first
paycheck in August. Include all local/annual, hourly/daily, midpoint (if
applicable), and extra duty tables.

O Click Save.

O Click Execute. Review the Simulation Process Error Listing and correct any errors
prior to continuing the process.

o Generate the simulation reports and review all salaries.

o Review the user-created report to confirm that all 10-month employees or
positions are included in the simulation. The reflected salaries are the
amounts that are used to pay employees in the current year payroll.

If necessary, continue making corrections and running the simulation until all of the
salary amounts are correct.

O Run the final simulation. This process updates the state step, pay step, and
salary amount in the next year PMIS for all 10-month positions and clears the
Accept Changes field.

son NameT) 5 1T 3  Simulation Deseription] o 1T STAFF MOVE )

SIMULATION OFTIONS FIRST PAY DATE CODES FUND/FISCAL YEAR EXCLUSIONS LOCAL ANNUAL HOURLY/DAILY EXTRA DUTY MIDPOINT DEDUCTIONS UPDAT|

et ] [ Add Simulation ] [ Execute ] [ Delete
Simulation Name: Simulation Description: [‘_f_ MTH STAFF MOVE ] User ID: LIZ

Calculation Options

Include Proposed Positions

V]

i
Include TEA Health Insurance:

o In the Update Forecast field, select Yes.
o Click Save.
o Generate and save the reports.
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o Click Process to process the simulation. Create a backup.

6. (If applicable) Move employees to next year payroll.

Log on to the next year.
Position Management > Utilities > Move Forecast to NY Payroll

If your LEA uses ASCENDER Grade Reporting and/or accrues, 10-month employees
may need to be moved to next year payroll.

Select Pay Frequency:

Update TRS Year Flag:

Select First Pay Date Codes or blank for ALL: [e‘\'l'C SNC,STC ] :

Include Extra Duty:

Select Extra Duty Codes or blank for ALL: [ ] .

Select Positions or blank for ALL:

{Includes ALL billets for selected positions [ ] :
Blank for ALL not processed when Positions/Billets selected)

Select Positions/Billets or blank for ALL: [ ] :
Select Supplement Positions or blank for ALL:

{Includes ALL billets for selected supplement positions [ ] :
Blank for ALL not processed when Supplements/Billets selected)

Select Supplement Positions/Billets or blank for ALL: [ ] :

O Complete the following:

o In the Select Pay Frequency field, select the frequency that represents the
LEA's next year payroll.

o Select Update TRS Year Flag.

o In the Select First Pay Date Codes or blank for ALL, select the first pay
date codes that represent the 10-month employees.

o Select Include Extra Duty pay.

The additional fields can be used to move select employees and positions.

O Click Execute. Generate the Move Forecast Process Error Listing and correct any
errors prior to continuing the process.

Processing Reports

Selact Report Mame
Mowe Forecast Process Error Listing ,
Update NYR Payroll From Forecast by Employee Name
D Update NYR Payroll From Forecast by Campus 1D
[ Generate Reports ] ’ Select All ] ’ Unselect All ]
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After completing any corrections, generate and save all of the processing
reports.

O Click Process to process the final simulation.

Contact your regional ESC consultant if you need assistance.

7. Complete these steps before proceeding.

[¢]

Ensure that the August payroll is processed.

Run the Regular Payroll (RP) extract with the Child Nutrition values (if
applicable) and interface to Finance in order to run the TRS On-Behalf process
and continue the end-of-year process in Finance.

Create a folder (e.qg., Preliminary Aug TRS Reports) and save all extracts for
verification purposes.

Do not report or submit any records to TRS at this time.

[¢]

o

[¢]

8. (If applicable) Perform the August accrual process.

Skip this step if your LEA does not accrue in ASCENDER.

After completing the August Accruals process and interfacing to Finance, ensure
that there are no changes to the employee’s distribution accounts until the August
accruals are posted to the payroll history as part of the end-of-year process (First
Payroll of the School Year Checklist).

9. Identify September start date employees.

Log on to the next year.

Position Management > Reports > User Created Reports > CYR/NYR Positions
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10.

Report Title

( J

PMIS Position/Distribution Export File Auto Select Options

[ PMis Position Cantrot [[] PMIS Position Distribution

D PMIS Position Control

Oy Ry E Flag Contract Beg Date

[ODay Empld Pet
OFct of Year
D Pay Concept

[JExtra Duty Code

O supplement Type

D Supplement Max Amt
D Base Suppl On Dly Rate
[ supplement Pay 1 Time
[ Date Supplement 1 Time
[ Accept Change

D Date Create/Update

[ pate Fin

D Fill Pesition Reason

[ Date Criteria

[Ooc Pay Type

D Suppl Recalculate

D Ign Pt Day For Sal Calcs
D Ign Pet ¥r For Sal Cales
[OHew Employee

ition Nbr

|_J Contract End Date
D Payoff Date

O mbr Days off

[ At Hrly Dly Rate
[ satary Amount
O nbr Remain Payments
D Job Category

D Supplement Attached
D Job Code

[ 15t Pay Date Code

D Calendar Code

D Campus ID

[OJoept

[ Hrs Per Day

t Nbr DPEr Grade
DPEr Step
[Oray schedule
Orre- i
Omidpeint B

DPE-’Q& rit of Midpeint
Duﬂe'ﬂolc-,-me'.t Elig Flag
[Orica elig

[OTRS Status Code
DBnget Armount
DBnget Salary O
[OActualiBudget Ind

[OJFay Tvpe

Yosition Type

*osition Description

ion Status

*nsition School Year
DFu'eq- =

DCu: Employee Nbr
[:|I"r-r" ary Job
Oincrease Elig

DOC: Fay Grade
DC.:: Pay Step
[Joee Pay Schedule

[5tate Step

Dh‘.aa Paymenis
Oovem elig Fig

DSta::‘ Minimum Days
[O5pver Position Nbr
[Jzover Bitlet Ner
DSJPO.QI“&-’\[ Extra Days
[J5upal to Pos Nbr
[J5upat to Pos Billet

D Date Aut
[ Date Entry

[ Data Inactive

eride

[JPMis Position Distribution

OcyRNYR Flag

Oieb Code

O account Type

[Eed span

D Project Detail

D Account Amount

[ Account Percant
TRS Grant Code

D Extra Duty Code

DE;.pef.s-:— 373

[Ocentrib Acct Flag

[ 5ub Object
[Jorganization
[OFriscal Year

D Program Intent

[Ooistribution Sequence

D Frequency

D Employes Demo

DM-ﬂc le Name DGe neration

Generate a user-created report to identify employees who have a 9/1 or later start
date.

Position Management > Maintenance > PMIS Position Modify > Position Record
Retrieve each employee.

For TRS purposes, select the Accept Changes field to avoid moving the employees
to the current year payroll.

Copy school calendars from next year to current year payroll.

Log on to the next year.

Payroll > Next Year > Copy NYR Tables to CYR > Copy Next Year Tables
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COPY NEXT YEAR TABLES *

: 10 |[(eeee ] [(enmuries
( 1 O :
[ ] 0
( ] O
( JoEl:
Midpoint Salary [ J|j @]
(
(
(
(

Accrual Calendar

Extra Duty Pay

Hourly f Daily Salary

Job Code

Local Annual Salary

‘imc:lCa.-&’-cz' BD.FS.MCTC ] >

State Minimum Salary ] D H
] 0
j/@] -

Substitute Salary

‘Workers' Compensation Rates

O In the School Calendar field, select only the 10-month employee calendars.

_ TIP: The calendar code is displayed in the first pay date code on
&  the simulation (e.g., J40 includes calendar code 40

O Click Execute.

Note: If changes were made to any of the next year payroll tables (extra duty
pay, hourly/daily salary, job code, local annual salary, etc.), copy the tables
from the next year payroll to the current year payroll.

11. Generate a user-created report.

Log on to the current year.
Payroll > Reports > User Created Reports

[ Generate a user-created report with the Hrs Per Day, Wkly Hrs Sched, and
Payoff Date fields selected. These fields are overwritten when positions are moved
from the next year to the current year.
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FRepart Template
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[Doistribution
Dt ] [m] ] Oray [m] ] | O
Oru O m] [m] (0 O [m] O O
Do O
[ Drechuction:
(OBee O O O Orets O O O

O Identify the employees who have an August payoff date, and then use the Mass
Update utility to update the fields after all positions are moved from the next year
to the current year.

12. Move forecast to current year position and payroll.

Log on to the next year.
Position Management > Utilities > Move Forecast to CYR Position and Payroll

This process is used to move payroll and position forecast records to the current
year PMIS with the same information that is set up in the next year PMIS records.

It also updates fields on the following Maintenance tabs: Employment Info, Pay Info,
Job Info, Distribution

The Accept Changes field must be cleared when moving position records from
forecast to current; otherwise, position records cannot be moved. The Accept
Changes field is cleared after running a simulation with the Update Forecast field
set to Yes. Similarly, you cannot run a simulation for positions without the Accept
Changes field selected.
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IGHDDD

o In the Select Pay Frequency field, select the payroll frequency to be
updated. LEAs with multiple frequencies must individually process each
frequency.

o Do not select Include Vacant Supplements.

o Do not select Validate Accounts against General Ledger at this time.
Distribution accounts in next year PMIS reflect the fiscal year for the
upcoming school year. Finance still reflects the current year for the fiscal year
in the general ledger. When running this process, the error report reflects
funds for employees who are included in the process. It is necessary to create
the funds with the new fiscal year on the Finance > Tables > Account Codes
> Fund tab. It is NOT necessary to set up codes in the Chart of Accounts.

o Do not select Update TRS Year. If an employee has this field selected but
they are now a 10-month employee, the TRS Year field is cleared when the
10-month move is processed.

o Select Update Workers’ Comp Annual and Remaining Payments if the
LEA expenses worker's compensation in ASCENDER. The system references
the # of months in Contract and makes the WC Ann Pymts and WC
Remaining Pymts match this field.

o Leave the Additional Workers’ Comp Payments field blank. It is not
necessary to populate this field even if the LEA expenses workers'
compensation in ASCENDER.

o In the Select a Stat Minimum Salary Table (CYR/NYR) field, select the
year (current or next ) that contains the tables with the updated amounts. If it
is a legislative year and the state minimum amounts are updated.

o In the First Pay Date Codes or blank for ALL field, select only the first pay
date codes for employees who receive their first paycheck in July.

o Select Include Extra Duty to include the supplement pay with the regular

pay.

O Click Execute to execute the process. The following reports are available:
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Process

Processing Reports

Report Mame

Mowe Forecast Process Ermor Listing
Update CYR Positions From Forecast

Update CYR Payroll From Forecast by Employee Name

oooo g

Update CYR Payroll From Forecast by Campus ID

| Genersterepons || setecrau

| [ unsetectau

o Move Forecast Process Error Listing Important errors

Error Message

Description

Warning: The employee
has Contract Balance
amounts not equal to zero
for current jobs.

The employee has not been paid off by
payroll.

Failure: Position Accept
Changes Flag setto Y

The position will not be moved to the
current/payroll.

Failure: Emp Nbr must
have one position declared
as primary.

The error does not necessarily reference the
Primary Job field on the position. If an
employee has a regular position and a
supplement position, but there is an error that
causes the primary position to fail, this
message often indicates that there is only a
supplement position to be moved. It is
recommended to review and correct any
errors that begin below this message about
primary positions. After making those
corrections, run the process again. This may
resolve the primary job errors.

This error also occurs when calendars have

not been copied to the current year.
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Error Message

Description

Warning: Emp Nbr has
multiple supplement
positions for the same job;
however, one or more of
the following do not
match: Campus ID, Dept,
TRS Status Code, FTE
Units, Incr Elig, Max
Paymts, FICA Elig, Unemp
Elig, EEOC, Workers Comp,
Supplement Extra Days or
Category Cd. The values
from lowest Supplement
Position Number/Billet
may be used if new rows
are inserted for the Pay
Info and Job Info tabs.

This error indicates that the fields on the
Payroll > Tables > Salaries > Extra Duty tab
do not match those selected on a
supplemental position.

Use the Position Management > Inquiry >
PMIS Staff Inquiry to determine the Position
Number and Billet for any supplemental
positions for the employee. Then, use the
Position Management > Maintenance > PMIS
Supplement Modify page to retrieve the
position and billet and compare the fields on
the position to the Payroll > Tables > Salary
> Extra Duty tab for the extra duty number
on the supplement. For example, in some
cases the W/C code on the position may not
match the W/C code on the table. Or, the Exp
373 field on the position may be selected, but
the Exp 373 on the table for that extra duty
code may not be selected. Either the table or
the position needs to be updated so that they
both match. If changes are made to the Extra
Duty table, it is necessary to move the table
to the current year payroll before proceeding.

Date Run: Move Forecast in CYR Position and Payroll Ermors
Cnty Dist: 15D Page: 1 of 4
Position Mbe Billet Mbr PosTyp Emor Message:

Failure: Emp Mor 000007 must hawe one position declzred 25 primary.
Failure: Emp Mor 000128 must hawe one position declared 2 primary.
Failure: Emp Mor 000148 must hawe one position declzred 2s primary.
Failure: Emp Mar 000200 hzs ungrocessed Reg Hours, Ovam Hours, or Abs Ded trensmittats.
Failure: Emp Mor 000200 must have one position declzred 25 primary.

Eailire: Erpn Ner 00498 muyet bave cne nosition declared == orime:

o Update CYR Positions From Forecast - The error report lists any funds that
need to be set up in the Finance tables.

Date Run: Update CYR Positions From Forecast

Cnty Dist: 15D Page 1 of 1
Position Mbr Billet Mbw  Pos Typ Description Emplioyes Number Employes Name

No Rows Mo Rows “acant
End of Repart

o Update CYR Payroll From Forecast by Employee Name
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Date Rurc Update NYR Payroll From Forecast by Employes Name
Cniy Disc 15D Page: 1 of 1
School Wear:
Employes Mame
News Field Oid Meswr Field Oid Mew
Freq:

Campus Contract Amount

Primary Job Contract Remain Amt

Creertime Eligible

Inzres ible

EEOC Code

Wrk's Comp Annl
‘Wrk's Comp Remain

Mbr Days Off

o Update CYR Payroll From Forecast by Campus ID

E0C Code

Wrk's Comp Remain

Date Run: Update NYR Payroll From Forecast by Campus ID
Cnity Dist- 15D Page: 1 of 1
School Year:
Emp Mbr Employee Name
Field Oid Mew Field Oid Newr Field Oid New
Mo Rowes Vacant Freq:
Employment Dzt Campus Confract Amount
Pay Sa=s Primary Joo Consract Remain Amt
FICA Eligible Oreastime Eligible Fay Rawe
Unemg Eligibls Eligible HriwDéy Rate
TRS Stz Calendsr Code Creertme Rate
Job Code Sizt= Sep Diock Rate
Pay Conospt TRS Year Saste Min Sslary
Pay Type TRS Position Code Mbr Mon Contr
Contract Begin Cate Accruzl Code Mbr Annl Pymts
Contract End Dzie Exampt Status Mbr Rem Pymts
Fayoff Date Mbr Days Contract Job Pt A==gnd
Fay Grads Mbr Days Empld Pct D=y Empld
Fay =0 Mzx Cays Hrs Per Day
Siched ‘Wik's Comp Annl Mbr Diays OfFf

O Click Generate Reports. The selected reports are displayed. Review the

report.

O Click Continue to view the next report. Or, click Return to return to the
report selection page.

O After reviewing all of the reports and correcting all errors, return to the report
selection page and click Process to move the forecast records to the current
year. You are prompted to create a backup.

After the process is completed, the actual update is performed. If the update
is successful, a message is displayed indicating that the move forecast
updates were successfully processed.

O Click Cancel to return to the Move Forecast to CYR Position and Payroll page
without moving the forecast records to the current year.

If corrections are processed, repeat this step.

Generate and save each report. Compare the Update CYR Positions From
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Forecast report to the user-created report that was previously generated to
confirm that all 10-month employees are included. The last two reports contain
the same information; one is sorted by employee name and the other by
campus ID. These reports reflect the existing salary in the current year payroll
and the new salary, which overwrites the current year payroll amounts. Review
the reports for accuracy.

13. Confirm that CYR salaries are accurate.

Log on to the current year.

Verify the current year data to confirm that the salaries are correct. The highlighted
fields are updated:

[ = B Year: C Frequency: © :
oo I T

PAY INFO 108 NFO DISTRIBUTIONS DECUACTIONS. LEAVE BALANCE

3|

RS FEP Staif Salary Data

Extra Duty Pay

Delete  Extra Duty Pay Coge Teoe Amourt, Femain Amt  Femain Pymis

Ma Rows
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Employee: [ [

PAY INFO JOB INFO DISTRIBUTIONS DEDUCTIONS LEAVE BALANCE

Delste  Selected | Job Code Brimary % Assigned EBay Type
] o] Contracted employee
Primary Campus: I
Dept: D
Rows: 10of 1 Add
Contract Info
Pay Type PayGrade:  [Tom w]  Pay Step Sched Max Days: Hrs Per Day Incr Pay Step

# of Annual Pymis Remaining Pymts

Balance I Concept:  Use midpy

se Annual

Ir"mL [ass0

# of Months in Cont

4753333

State Min Days:

187 Valid basic days in

Daily Rate: - Contract Total: # of Days Empld: Vaantiob: [

Pay Rate: T = Contract Total e 3 # Annual Pymts. Whly Hrs Sched

Reg Hrs Worked: OVTM Elig: D OVTM Rate: n Hrly Rate: cnd classrm teach W

State Info

State Step: Wrs in Creer Ladder RS Year: (] I TRS Member Pos: v I Whally Sep Amt T

State Min = Foundation X % x Hofdays Retiree

Salary 1000 Daily Rate o Assigned: Empld z Exception: | |

Calendar/Local Info

Calendsr C&  (rrTa7omn 3 Begin Date % Tataoar] E90ete  riapag]  AofDeysEmpls:

Years Job Exp: D Local Contract Days:

Exclude Days fi

Workers' Comp Info

WCCode: (G 863 PROFIAID V) WE A Pymes, WCR

Accrual Info

| Code: i Accrual Rate e | = Total e B # of Days Empld e

et e =1
s = = o]

PAYINFG  JOBINFO  DESTRIBUTIONS — DEDUCTIONS  LEAVE BALANCE

Delste  Detsils Job Code ExtraDuty  Account Type Accourt Code Amount  Pertent
] 1402 - SEC TEACHER - MATH G 195-11-6119.00-001-430000 £9.50000 | 100.000%
Total 4960000 100.000%
Row Bafroch Tosals Ay
Jeo Cocy 12032 - SEC TEACHER - MA
Account Type e
PR Lt ‘s Comp Code:  8868-PROFAIDES/ADMS
Dgscrigtion: SALARIESTEACHER & OTHER PROF Expane 373 = o
Amount [ 29.50000] eut of 49.500.00 Emstayer Cartetusion: [
Pafcant 1 O0%
e 10 ] Performance Pay- D

14. Mass update the fiscal year.
Log on to the current year.
Payroll > Utilities > Mass Update > Employee
Skip this step if your LEA has a 7/1 fiscal year.

Mass update the fiscal year to the next school year for all employees.
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Select Fiscal Year and type the next year fiscal year. Before processing, stop to
consider if the LEA uses other fiscal years in the account codes for employees. If the
entered year is not the only used fiscal year, additional parameters may need to be
selected.

Contact your regional ESC consultant if you need assistance.

Mass update the current year Wkly Hrs Sched and Hrs Per Day fields.

o Select Wkly Hrs Sched and type the number of hours displayed for the
majority of employees. Any exceptions can be manually updated in the
current year payroll. Reference the previously generated user-created report.

o For LEAs that use the hours per day functionality in the current year payroll,
select the Hrs Per Day field and type the number of hours per day for the
majority of employees.

o Use the parameters to select specific groups of employees for the update.

15. Generate the HRS6000 Account Code Comparison Report.

Payroll > Reports > Payroll Information Reports > HRS6000 - Account Code
Comparison

This report compares the account code on the employee’s master distribution
record and compares it to the Chart of Accounts in Finance file ID C.

Complete the following parameters.

HRSE000 - Account Code Comparison

Parameter Description V.iue
o Sort by Alpha (8), Pay Campus (C), Primary Campus [P)

Include Reports (Select From List)

From Diate (MMDOYYYY) 0901 20X

o Date (MMDDYYYY)

Pay Status Active (A), Inactive (1], or blank for ALL
Poy T 1-4,0rlrkfor ALL E—
Select Pay Campus(es), or blank for ALL [:] H

Select Primary Campus/(e

T —

Select Employes(s), or blank for ALL :} H
Date Run: Payroll Account Code Comparison Program: HRSE000
Cnty Dist: 15D Page: 1of 10
Froquency: E
Account Codes in Distribution that DO NOT EXIST in Budget
Alphabetic List
Account Code Emp Nbr Employes Nama Job Code
190-11-6120.00-04 1-811000 000183 B 1454 - SEC INSTRUCTIONAL AIDE
190-11-6119.00-04 1-811000 0D0oe1 1405 - SEC TEACHER - READING
196-11-6129.00-101-823000 000604 —_— 1354 - ELEM INSTRUCTIONAL AIDE

If your LEA has multiple pay frequencies, generate the report for each frequency.
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The generated report should be blank. If any account codes are listed, determine if
the account codes need to be added to the Chart of Accounts in Finance or if the
employee distribution record needs to be modified.

16. Generate the HRS6050 Contract Balance Variance Report.

Payroll > Reports > Payroll Information Reports > HRS6050 - Contract Balance
Variance Report

This report looks at the pay rate for each employee and multiplies it by the number
of remaining payments, and compares that amount to the Contract Balance on the
Job Info tab. If there is a variance of more than a few pennies, perform manual
calculations to determine if any corrections are needed.

Generate the report for pay type 1 and again for pay type 2.

O Complete the following parameters:

[ Preview ] [ FOF ] [ Csv ] [ Clear Options ]
Payroll Information Reports HRSE050 - Contract Balance Variance Report
HRS51250 - Employee Data Listing -
HRS1650 - Employee Salary Information A
HRS&000 - Account Code Comparnison Parameter Deacription Vol
HS6050 - Convors Bolane Voo Repert /0 oo ), Poy Campus (0, Prney Campas P
HRS ¢ Verification Report ( Maximum Acceptable Difference
HRS alth Insurance Coverage
HRS6E50 - CYR/NYR Salary Comparison \E{E‘.&tus;’\cdve{.ﬁ.:. Inzctive |I], or blank for ALL !
Pay Type 1-4, or blank for ALL
Select Pay Campusies). or blank for ALL :] H
Select Primary Campus(es), or blank for ALL :] H
Select Employee(s). or blank for ALL :] H
[Gate Run: Coniracl Balance Varance Reporl Program: HRSEOS0
Crty Dist: ISD Page: 1 of 2
Variance Threshold:  0.10 Frequancy: E
Emp Nbr Employee Nama Job Cd Pay Rate Remain Pymts  Computed Bal Actual Bal Varlanco
000018 AGUILAR, AIDA 1602 11.32 24 27168 16478.00  16,206.32
000148 AHOURLY JR, OMLY M 1504 14.38 24 34512 2991000 29564.88
000831  AHOURLY, REGULAR 1504 10.24 24 24578 2120900 21,053.24
000060  AYALA, ANA M 1154 1,150.38 24 27.609.12 27.609.00 =12
000080 BEASLEY. ANTONIO 1602 11.02 24 286.08 1582400 15537.92
000085 BERRELEZ BARBARA L 1353 89388 24 2145312 21,453.00 =12
000097 BERRELEZ BELINDA ROSARIO 1602 88.35 24 212040 16.522.00  14.401.60
000102 BISHOP, BENITA IRENE 1455 820.38 24 19,689.12 19,689.00 =12
000148 CANTU, CARMEN 1702 15.66 24 aT5.84 2254500  22169.16
000167 CARRIZALES, CHERYL K 1505 13.82 24 33168 28,746.00 28.414.32
000187 CASTRO-VELA, CONCEPCION C 1309 2,135.38 24 51,240.12 51,249.00 =32
000183 CERVANTES, CONSUELO 1502 15.93 24 38232 3313400 3275168
L0008 CORRES DAMIE] 1508 1349 24 29 Ad 2TRGY00 OF 574 18 |

17. Enter new hire data.

Log on to the current year.

Use the Staff Job/Pay Data pages to enter new hire data. The HRS1550 - New Hire
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Report is helpful to identify these employees.

When new hires are entered in the next year Position Management and moved to
the current year payroll, only the fields related to the position are populated.

Manually update the following:
Personnel > Maintenance > Employment Info

o Employee Status

Highest Degree

Percent Day Employed

Original Employment Date or Latest Re-Employment Date
Retirement Date (if applicable)

o Years of Experience

o Employment Type

[¢]

[¢]

[¢]

o

Payroll > Maintenance > Staff Job/Pay Data > Pay Info

o Pay Campus

FICA Eligibility
W-4 Marital Status
Nbr of Exemptions
Bank Information

[¢]

o

[¢]

[¢]

Complete the Payroll > Maintenance > Staff Job/Pay Data > Deductions tab.

Payroll > Maintenance > Staff Job/Pay Data > Leave Balance - This tab can be
updated in September using the First Pay Date of the School Year instructions.

18. Process TRS extracts and submit records/files.

Payroll > Payroll Processing > TRS Processing > Extract

Process and submit all of the TRS extracts. Do not interface when processing the
Regular Payroll (RP) extract.

19. Clear the Accept Changes field.

Position Management > Maintenance > PMIS Position Modify > Position Record

After all of the August TRS reports are in a completed status, clear the Accept
Changes field in the next year PMIS for employees with a September start date.

20. Move calendars.

Move the TRS calendar and any calendars that pertain to employees with a 9/1 or
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later start date.

21. Move employees with a September 1 or later start date to CYR.

Log on to the next year.
Position Management > Utilities > Move Forecast to CYR Position and Payroll

Move employees with a 9/1 start date or later to the current year payroll. You can
individually select employees. It is important to select ALL Position/Billets and
Supplement Positions/Billets for the employee.

< Select Pay Frequency:

5
Include Vacant Supplements: D

( ‘alidate Accounts against General Ledger: )

Update TRS Year Flag:

< Update Workers' Comp Annual and Remaining Payments:

Add Additional Workers' Comp Payments:

c Select State Mininmurn Salary Table (CYR/MYR):

Select First Pay Date Codes or blank for ALL:

Include Extra Duty:

Select Extra Duty Codes or blank for ALL:

Select Positions or blank for ALL:
{Includes ALL billets for selected positions [r!s,.-.,1 102,P5A1103 ]
Blank for ALL not processed when Positions/Billets selected)

Select Positions/Billets or blank for ALL:

l N

Select Supplement Positions or blank for ALL:
{lncludes ALL billets for selected supplement positions
Blank for ALL not processed when Supplements/Billets selected)

Select Supplement Positions/Billets or blank for ALL:

Clear Job Years:

Clear Job Weeldy Hours Scheduled:

l | I

B
O

22. Run payroll calculations.

Log on to the current year.

Payroll > Payroll Processing > Run

Payroll

Run payroll calculations to verify any errors.
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